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Chapter 1 About Color Tools 
 

1.1 Scope of Application 
The Color Tools in Founder ElecRoc 6 workflow is applied in two directions: digital proof 
and digital print.  
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Chapter 2 Installation and Un-installation 
2.1 Install the Software 
The Color Tools is always installed on your ElecRoc client machine, irrespective of 
whether your ElecRoc Client is running on ElecRoc server or on a separate computer. It 
doesn’t have to be installed with the proof device or the digital printer either, i.e. the 
Tools and the device are allowed to run on different computers.  

The steps for installing the Color Tools are as follows:  

1. Double-click the file setup.exe under ElecRoc’s install DVD directory Options\Color 
Tools\, or choose Install Color Tools if you have entered in ElecRoc’s autorun window.  

 
Figure 2 

2. The install program starts up, displaying first the welcome window.  
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Figure 3 

3. Click Next to enter in the customer information window.  

 
Figure 4 

4. Input your information and then click Next, to enter in the setup type window.  
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Figure 5 

5. Choose Custom and click Next, and then you can see the following window, designed 
for you to choose the destination folder. If needed, you can click Browse to customize 
the destination folder.  

 
Figure 6 
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6. And after that, click Next to open the dialog box below. Check Color and click Next.  

 
Figure 7 

7. In the pop-up window, click Install.  

 
Figure 8 
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8. It then pops up the status window, showing the progress of the installation.  

 
Figure 9 

9. When the progress bar reaches 100%, the install program hints that the installation 
has been completed. Click Finish to exit.  
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Figure 10 

Note: Due to that the Color Tools is designed to be started up from ElecRoc’s Client, thus 
the startup icon for it is NOT available on your desktop or in your Start menu, where you 
can only see its uninstall icon.  

2.2 Uninstall the Software 
1. Choose Start > All Programs > Color Tools > Uninstall Color Tools to open the 
following dialog box. This dialog box can also be opened by choosing Start > Control 
Panel > Uninstall a program > Color Tools > Uninstall.  

 
Figure 11 

2. Choose Remove and then click Next. And then in the pop-up dialog box, choose Yes 
to confirm the removal.  

 
Figure 12 

3. Click Next to begin the removal. The bar shows the progress.  
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Figure 13 

4. When the bar reaches 100%, click Finish to exit.  

 
Figure 14 
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Chapter 3 For Digital Proof 
3.1 Start up Color Tools 
The Color Tools can NOT be started up independently. Instead, you need to start it from 
ElecRoc’s Client. The steps are as follows:  

1. Run your ElecRoc workflow system. On the ElecRoc server, double-click the short-cut 
icon  on the desktop, to start up ElecRoc Server.  

 
Figure 15 

2. Start your proof processor you want to proof, making it online.  

3. Start up ElecRoc Client and login the Server. Double-click the short-cut icon  on the 
desktop, to start up ElecRoc Client.  

 
Figure 16 
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4. Input correctly the server name or its IP address, and then click OK to enter in the 
Client’s user interface.  

 
Figure 17 

5. Choose the administrative module Administrator > Processor Management, find 
out and choose the proof processor, here we take Epson 7910 pre-RIP as example.  

 
Figure 18 

6. Click the Proof button, and then you can see that ElecRoc automatically creates a job, 
named as Proof_Epson Stylus Pro7910, dedicated for your proof operation.  
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Figure 19 

Note: By default, this job contains only two processors, one is hot folder, used for 
receiving data, and the other is the proof processor, i.e. Epson 7910.  

7. Configure Epson 7910’s processor parameters. As shown in the figure below, 
double-click the Epson 7910 node in the job, to open its parameter setup window.  

 
Figure 20 
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8. Properly configure the device-related parameters as you need, and then click the 
Proof button at the bottom of the setup window, to start up the Color Tools.  

 
Figure 21 

9. For use in digital proof, choose Digital Proof, and then click OK.  

3.2 Create Proof CMF 
In this section, we will introduce you the digital proof process. This process will produce 
a .cmf proof file.  

The proof process for digital proof is composed of 8 steps:  
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Figure 22 

The main interface for the Color Tools is shown as follows.  

MultiColor 

Loop 
Print 

Device State 

Source 
Characterization 

Color Data 
Packaging 

Linearizati
on Measure 

Circular 
Calibration 

Loop 
Print Measure 

Device 
Characterization 

CMF File 
Generation 

Print test 
chart 



                      Color Tools User Guide 

14 

 
Figure 23 

Click the toolbar icon , or choose the main menu File > New CMF, to start up the proof 
wizard. The program first pops up a parameter setup window.  

 
Figure 24 
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New / CMF File Name: The name of the new CMF file that you are going to create.  

Open / Load CMF File: You can open a CMF file that has been interrupted or unfinished 
during its creation. A finished CMF file can NOT be opened here.  

Color Wizard Procedure: Please tick the steps or procedures your proof contains. A 
complete proof wizard contains 8 steps.  

Custom Info: Here you can input some text for identification, if needed.  

Click the button Properties Setup at the top of the window, to define the following 
parameters.  

 
Figure 25 

CMF Path: This path is designed for storing the generated .cmf files. We recommend you 
to use the directory \\172.19.xx.xx\Elecroc\Resources\Proof2\ColorCorrection\34, 
172.19.xx.xx referring to the IP address or computer name of your ElecRoc server, 34 
referring to the ID of the proof processor in your ElecRoc system. This directory is also 
the default path to store the .cmf files that are ready for use by your proof processor. 
Only finished CMF files can be generated under this path.  

Backup Path: This path is used for storing the data resulted in case of any interruption 
or incompletion in the CMF file creation.  

Print Path: This path is used for storing the files that are to be printed during the CMF 
file creation. The default path is \\172.19.xx.xx\Upload\Proof\34, 172.19.xx.xx referring 
to the IP address or computer name of your ElecRoc server, 34 referring to the ID of the 
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proof processor in your ElecRoc system. This path is also the path where the hot folder in 
your proof job detects for printing chart files.  

Measure Device: Please choose the measuring device you are actually using. Color 
Tools supports you to use Eye-one ISIS, Eye-one, or Eye-one IO. In this manual, we take 
the Isis as example, the color charts will thus be based on this device.  

CMYK Black Reserve: If checked, the system will directly use black ink to print the pure 
black process color (only the K in CMYK is NOT equal to 0 in this case). It’s NOT suggested 
for digital proof.  

Print Width: This refers to the width of the media that you are loading on your proof 
device. Please input the value as per that of the actual media.  

Recalibration Threshold: It refers to the dE threshold for recalibration.  

Step 1: Multicolor 
This step is applied to some ink printers from Epson and HP. Its purpose is to generate a 
profile based on specific paper and printer, ensuring that CMYK colors can be properly 
output by multi-color inks of the printers.  

 
Figure 26 
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You can load an existing multicolor file, or choose to use the default one, or you can 
create a new file by way of printing & measuring.  

If you choose to create a new file, we suggest you to click the button Auto Pick Node 
after the measurement. This clicking enables the wizard to automatically pick the nodes 
for you, a convenience for you in generating the multicolor file.  

Step 2: Linearization 
The second step is to create the linearization file.  

 
Figure 27 

The linearization file can be loaded, or can be created by printing & measuring.  

Click the button Setting to open the Parameter Setting window.  
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Figure 28 

First, please choose the paper type according to the media type you are using.  

Then, choose a mode for creating the linearization file: DotGain Mode or Density Mode.  

Suggestion: Choose Density Mode if you are using dedicated proof paper; DotGain 
Mode is applied for proofing on printing paper.  

When you have done the setting, click OK to return to the main window.  

Click the Print button (the button Measure is then activated) to generate the 
corresponding linearization chart under the Print Path specified in the Property Setup 
window (opened by clicking Property Setup when you created the new CMF).  

Note: The generated chart file under the print path will then be scanned and submitted 
to the printing device by way of hot folder.  

Click Measure to enter in the measuring window.  
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Figure 29 

Measure the printed chart, and when you finish the measurement you will see the hint 
“Measured successfully! Press here to continue”.  

 
Figure 30 

Click this hint to back to the main window. 
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Figure 31 

Now you can see that the Print button turning to Loop Print, and an option Create 
Linearization Target appearing (checked by default) on the interface.  

Create Linearization Target: You need to create a target data in case that you want to 
perform a quick re-calibration operation in the future. When your device has been used 
for a period of time or its state has been changed, you can make use of the 
Re-calibration > Quick Calibration to restore your device to the state it had when you 
made the color calibration solution.  

Note: 1) The Next button is grayed when this option is being checked, but becomes 
activated when you print and measure once again. 2) In case that you choose to load a 
linearization file and the file contains target data, the target data will be loaded with the 
file together. And if the loaded file does NOT contain this data, if needed, you can print 
and measure to create it.  

Click the button Loop Print, and then repeat the measurement when the chart has been 
printed out, till that the color difference shown at the lower-right corner meets your 
requirement.  
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Figure 32 

Files involved in the calibration wizard are saved automatically. At the Result column 
shows in turn the generated linearization files, Linearization_1 … Linearization_n. And 
meanwhile the maximum and average differences for each loop printing and measuring 
are shown on the interface as well.  

After the generation of the linearization file, click Next to enter into the interface for total 
ink amount.  

 

If you are NOT satisfied with the generated linearization file, you can edit it, although the 
editing operation is NOT suggested for most users, for that it is an advanced adjustment.  

Click the Edit Curve button at the bottom of the window to open the editing window, in 
which you can view and edit the generated linearization curve file.  
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Figure 33 

Note: Aiming at re-defining specific ink percentage values, the editing becomes 
available only when you have checked the boxes in front of the percentages. Please note 
the monotonicity of the curve during the editing.  

If you have edited the curve, you can click Print, to apply the edited curve to print out a 
test chart, so as to check the actual linearization effect. Look over the printed chart with 
your eyes, a good linearization effect has the following characteristics: well-proportioned 
monochromatic color gradation, no mergence, composite colors of three equivalent color 
components at the bottom of the chart, no remarkable variance, and consistent hue. If 
you are NOT satisfied with the print result, you can continue to edit it. If satisfied, click 
OK to return.  

Note: If you have edited the curve and clicked OK, you will be hinted then that the target 
data created previously is no longer matching with the current device state, and that it’s 
best for you to print and measure again. In this case, please print and measure again to 
get new linearization target data.  

Step 3: Total Ink Amount 
This step is used for determining the total ink amount. The main window displays the 
chart used for deciding the total ink amount.  
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Figure 34 

The chart consists of two halves, the upper half is used for auto measuring, and the lower 
half is used for you to make decision with your eyes. Please refer to the method below to 
choose a right color block, and then combine the value corresponding to the color block 
and the measured value to decide a suitable total ink amount.  
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Figure 35 

Click the Print button to print out this chart, and then measure the upper half of the chart. 
The measuring result is shown aside Recommend Ink value. And meanwhile, choose 
the right color block with your eyes from the lower half of the chart. Based on the 
recommend value and the value in front your chosen color block, input proper values into 
the CK, MK, and YK edit boxes.  

Method to choose the color block: it is best to observe the chart just after it has been 
printed out. ①The color block without any flowing or heaping ink, and exactly in front of 
the semi-dry one. ②The thin white lines on the blocks are designed for inspecting the ink 
penetration. Heavy penetration usually causes the white lines to fragment or disappear. 
In case that the paper is of high quality, you'd better choose the one on which the white 
lines are clearly visible. ③In case that the paper is of coarse quality, you should inspect 
the ink penetration from the back side of the paper. The total ink amount is considered 
high if the ink penetration is so heavy that the paper has been obviously distorted. You 
can choose a block with neutral penetration.  

Note: the method above is used for reference only. In actual work, please make your 
decision flexibly according to the paper type, the measuring result and visual inspection.  

Click Next to enter into the main window for device calibration. 

Step 4: Device Calibration 
As an optional step, it is designed to create the device state file. Its main window is 
shown as follows.  
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Figure 36 

Only when you have created the device state file in this step, you can then make use of 
the module Re-calibration > Entire Calibration. The calibration file can be loaded, or 
be created by way of printing and measuring.  

As to creating a new one, please click the Print button to print out the color chart and 
then measure it. After the measurement, click Next to enter into the main window of 
device characterization.  

Step 5: Device Characterization 
This step is designed to create the color characterization profile for your current digital 
proofing device. It also allows two methods, being loaded or created.  
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Figure 37 

Take the creating of a device characterization profile as example. Click the Print button 
on the main window to let the printer output the ECI2002 chart, and then click Measure 
to measure it.  

After the measurement, click Create to start creating the characterization profile. The 
Calculate progress bar shows the progress of the file generation. The generated profile 
will then be displayed, like ProfileD_0.tmp.  

Click Next to enter into the main window for source characterization.  

Step 6: Source Characterization 
You can choose to load a characterization profile, or choose to create a new one by 
measuring the press sample of the ECI2002 color chart.  
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Figure 38 

As shown on the interface, the Color Tools builds in several international standard source 
profiles for you to choose. After the loading, you can click the Edit button to modify the 
saturation of the loaded profile. The modifying operation is NOT recommended for 
general users.  

 
Figure 39 

Click Next to enter into the interface for generating the data package.  

Step 7: Color Data Packaging 
This step is designed to package the proof data into a single proof file *.cmf.  
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Figure 40 

Note: If you haven’t set the source ICC in previous step, you can click the button  
aside the parameter CMYK Source, to specify a source ICC you will use.  

CMYK-CMYK Setting: To affect the color output of the CMYK entities in job.  

RGB-CMYK Setting: To affect the color output of the RGB entities in job, enabling the 
RGB entities to be output as per the color effect specified by the Simulation ICC option.  

Gray-CMYK Setting: To affect the color output of the Gray entities in job, enabling the 
Gray entities to be output as per the color effect specified by the Simulation ICC option.  

Rendering Intent: It’s a mode of color conversion and is available for each color space. 
Its four options enable different conversion results. Among them, the Relative 
Colorimetric is the most commonly-used option. Absolute Colorimetric is used when 
you want to simulate the paper white of the source device.  

Click the button Package Color Data to generate the .cmf file when you have defined 
the above settings. After the generation, the three Print Chart buttons become 
activated, and by clicking them, you can print out respectively the test page for the CMYK, 
RGB, and Gray modes, for purpose to view the color output effect of the current proof 
data.  

Click Next to enter into the main window for circular calibration.  
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Step 8: Circular Calibration 
The purpose of this step is to enable a better match between the output result of current 
device and the source characterization profile, so as to achieve an accurate simulation 
and an optimization on the color effect.  

 
Figure 41 

By default, the option Create Status Target on the main window is checked, and the 
button Finish is grayed. The purpose for creating status target is to get the device’s 
status result data that are output with current proof file, as a basis for evaluating color 
output result. If you don’t want to perform the circular calibration, you can uncheck 
Create Status Target to activate the Finish button.  

Loop Counter counts the times you have repeated (circulated). The button Print Chart 
enables you to print out the effect of the current circular calibration each time when the 
calculation is completed.  

Click Print to print out the ECI2002 color chart (at this time the chart is applied with 
proof data) and then measure it. Return to the main window when you finish the 
measurement, and you will see that the button Calculate becomes activated. Click it, 
and when the calculation is completed, you will see the average Delta E value being 
displayed at the Result column. This value at the first time is usually large. Now you can 
start the loop calibration, i.e. to repeat the Print, Measure and Calculate operations. In 
general, the Delta E will be reduced to a quite ideal value after two loops, and then you 
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can stop the circular calibration.  

Please click Finish to exit the calibration wizard. The generated .cmf file is stored under 
the CMF Path defined in the Properties Setup window (opened by clicking Properties 
Setup at the beginning of the wizard). Meanwhile the status target data is recorded in 
the proof file.  

3.3 Apply CMF File 
1. Run your ElecRoc Client, and open or create a job. The job should contain the PDF 
Generator and the Proof nodes.  

 
Figure 42 

2. Configure the Proof node’s processor parameters. At the CMF File dropdown list, 
choose the .cmf file you have just finished.  
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Figure 43 

3. Submit pages to the Proof node when you have done the configuration. The Proof node 
can accept directly the output pages from PDF Generator.  
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Chapter 4 For Digital Print 
4.1 Start up Color Tools 
The Color Tools can NOT be started up independently. Instead, you need to start it from 
ElecRoc’s Client. The steps are as follows:  

1. Run your ElecRoc workflow system.  

2. Start the digital printing processor you want to proof, making it online.  

3. Start up ElecRoc Client and login the Server.  

For details about the above three steps, please refer to Section 3.1.  

4. Choose the administrative module Administrator > Processor Management, find 
out and choose the proof processor, here we take C6000 as example.  

 
Figure 44 

5. Click the Proof button, and then you can see that ElecRoc automatically creates a job, 
named as Proof_FZC6000, dedicated for your proof operation. Meanwhile, the Color Tools 
will be started up, please choose Digital Print.  
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Figure 45 

6. Configure FZC6000’s processor parameters. The Output parameters are to be 
configured as per your actual needs, while the Use CMF file dropdown list under the 
Color Calibration tab needs to be set to None. 
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Figure 46 

7. Now we can start the proof work.  

4.2 Create Proof CMF 
In this section, we will introduce you the proof process for digital print. This process will 
produce a CMF proof file.  

The proof process for digital print is composed of 7 steps. Due to that most digital 
printers are 4-color devices, thus the multicolor step included in digital proof is not 
needed.  
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Figure 47 

On the main interface of the Color Tools, click the toolbar icon , or choose the main menu 
File > New CMF, to start up the proof wizard. The program first pops up a parameter 
setup window.  
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Figure 48 

New / CMF File Name: The name of the new CMF file that you are going to create.  

Open / Load CMF File: You can open a CMF file that has been interrupted or unfinished 
during its creation. A finished CMF file can NOT be opened here.  

Color Wizard Procedure: Please tick the steps or procedures your proof contains. A 
complete proof wizard contains 8 steps. But for digital printers, the Multicolor is usually 
not needed.  

Custom Info: Here you can input some text for identification, if needed.  
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Click the button Properties Setup at the top of the window, to define the following 
parameters.  

 
Figure 49 

CMF Path: This path is designed for storing the generated .cmf files, we recommend you 
to use the directory \\172.19.xx.xx\Elecroc\Resources\CMF\25, 172.19.xx.xx referring 
to the IP address or computer name of your ElecRoc server, 25 referring to the ID of the 
digital printer processor in your ElecRoc system. This directory is also the default path to 
store the .cmf files that are ready for use by the digital printer processor. Only finished 
CMF files can be generated under this path.  

Backup Path: This path is used for storing the data resulted in case of any interruption 
or incompletion in the CMF file creation.  

Print Path: This path is used for storing the files that are to be printed during the CMF 
file creation.  

Measure Device: Please choose the measuring device you are actually using. Color 
Tools supports you to use Eye-one ISIS, Eye-one, or Eye-one IO. In this section, we take 
the Isis as example, the color charts will thus be based on this device.  

CMYK Black Reserve: If checked, the system will directly use black ink to print the pure 
black process color (only the K in CMYK is NOT equal to 0 in this case). It’s suggested for 
digital print.  

Print Width: This refers to the width of the media that you are loading on your proof 
device. Please input the value as per that of the actual media.  
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Recalibration Threshold: It refers to the dE threshold for recalibration.  

Click OK after you have done the above settings. The following dialog box appears. 
Please make sure that your digital printer has already been adjusted before the proof.  

 
Figure 50 

Click OK to enter into the wizard.  

Step 1: Linearization 
The first step is to create the linearization file. The method is same as that for digital 
proof. The details are as follows.  

 
Figure 51 

The linearization file can be loaded, or can be created by printing & measuring.  

As shown on the interface, there are two loop types: Gray Delta E First and DotGain 
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First. Choose DotGain First if you want to make a complete proof file. Gray Delta E 
First is recommended in case that you want only to create Linearization curve. And if 
checked, you see that an option Max Gamut becomes activated. A checking on it is 
suggested.  

Click the button Setting to open the Parameter Setting window.  

 
Figure 52 

First, please choose the paper type according to the media type you are using.  

Then, set Max Density values, you can set the parameter Max Density Set to 
Calculate, and then specify a proper Source Profile to calculate automatically the Max 
Density values.  

As to the DotGain curve, the default setting is recommended.  

When you have done the setting, click OK to return to the main window.  

Click the Print button (the button Measure is then activated) to generate the 
corresponding linearization chart under the Print Path specified in the Property Setup 
window (opened by clicking Property Setup when you created the new CMF).  

Note: The generated chart file under the print path is a .tif file. Please use device’s 
printer server to print, note that you need to disable the color control of the output 
software when you print the chart file.  
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Click Measure to enter in the measuring window.  

 
Figure 53 

Measure the printed chart, and when you finish the measurement you will see the hint 
“Measured successfully! Press here to continue”.  

 
Figure 54 

Click this hint to back to the main window. Now continue to print, as indicated by the 
arrows on the window, the printed chart at this time is shown as follows.  
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Figure 55 

After the printing, continue to click Measure, to enter in the measuring window again. 
And return to the main window after the measurement.  
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Figure 56 

Now you can see an option Create Linearization Target appearing (checked by default) 
on the interface.  

Create Linearization Target: You need to create a target data in case that you want to 
perform a quick re-calibration operation in the future. When your device has been used 
for a period of time or its state has been changed, you can make use of the 
Re-calibration > Quick Calibration to restore your device to the state it had when you 
made the color calibration solution.  

Note: 1) The Next button is grayed when this option is being checked, but becomes 
activated when you print and measure once again. 2) In case that you choose to load a 
linearization file and the file contains target data, the target data will be loaded with the 
file together. And if the loaded file does NOT contain this data, if needed, you can print 
and measure to create it.  

Click the button Loop Print, and then repeat the measurement when the chart has been 
printed out, till that the color difference shown at the lower-right corner meets your 
requirement.  
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Figure 57 

Files involved in the calibration wizard are saved automatically. At the Result column 
shows in turn the generated linearization files, Linearization_1 … Linearization_n. And 
meanwhile the maximum and average differences for each loop printing and measuring 
are shown on the interface as well.  

After the generation of the linearization file, click Next to enter into the interface for total 
ink amount.  

 

If you are NOT satisfied with the generated linearization file, you can edit it, although the 
editing operation is NOT suggested for most users, for that it is an advanced adjustment.  

Click the Edit Curve button at the bottom of the window to open the editing window, in 
which you can view and edit the generated linearization curve file.  
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Figure 58 

Note: 1) The Edit Max Density and Edit Yule-Nielson options are grayed when you are 
viewing or editing the curve. 2) Aiming at re-defining specific ink percentage values, the 
editing becomes available only when you have checked the boxes in front of the 
percentages. Please note the monotonicity of the curve during the editing.  

If you have edited the curve, you can click Print, to apply the edited curve to print out a 
test chart, so as to check the actual linearization effect. Look over the printed chart with 
your eyes, a good linearization effect has the following characteristics: well-proportioned 
monochromatic color gradation, no mergence, composite colors of three equivalent color 
components at the bottom of the chart, no remarkable variance, and consistent hue. If 
you are NOT satisfied with the print result, you can continue to edit it. If satisfied, click 
OK to return.  

Note: If you have edited the curve and clicked OK, you will be hinted then that the target 
data created previously is no longer matching with the current device state, and that it’s 
best for you to print and measure again. In this case, please print and measure again to 
get new linearization target data.  

Step 2: Total Ink Amount 
This step is used for determining the total ink amount. The main window displays the 
chart used for deciding the total ink amount. This step is the same as that for digital 
proof.  
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Figure 59 

The chart consists of two halves, the upper half is used for auto measuring, and the lower 
half is used for you to make decision with your eyes. Please refer to the method below to 
choose a right color block, and then combine the corresponding value and the measured 
value to decide a suitable total ink amount.  

Click the Print button to print out this chart, and then measure the upper half of the chart. 
The measuring result is shown aside Recommend Ink value. And meanwhile, choose 
the right color block with your eyes from the lower half of the chart. Based on the 
recommend value and the value in front your chosen color block, input proper values into 
the CK, MK, and YK edit boxes.  

Method to choose the color block: it is best to observe the chart just after it has been 
printed out. ①The color block without any flowing or heaping ink, and exactly in front of 
the semi-dry one. ②The thin white lines on the blocks are designed for inspecting the ink 
penetration. Heavy penetration usually causes the white lines to fragment or disappear. 
In case that the paper is of high quality, you'd better choose the one on which the white 
lines are clearly visible. ③In case that the paper is of coarse quality, you should inspect 
the ink penetration from the back side of the paper. The total ink amount is considered 
high if the ink penetration is so heavy that the paper has been obviously distorted. You 
can choose a block with neutral penetration.  

Note: the method above is used for reference only. In actual work, please make your 
decision flexibly according to the paper type, the measuring result and visual inspection.  
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Click Next to enter into the main window for device calibration. 

Step 3: Device Calibration 
As an optional step, it is designed to create the device state file. Its main window is 
shown as follows. This step is the same as that for digital proof. 

 
Figure 60 

Only when you have created the device state file in this step, you can then make use of 
the module Re-calibration > Entire Calibration. The calibration file can be loaded, or 
be created by way of printing and measuring.  

As to creating a new one, please click the Print button to print out the color chart and 
then measure it. After the measurement, click Next to enter into the main window of 
device characterization.  

Step 4: Device Characterization 
This step is designed to create the color characterization profile for your current digital 
printer. It also allows two methods, being loaded or created. This step is a little different 
from that for digital proof. There is an additional item Setting on the interface.  
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Figure 61 

Take the creating of a device characterization profile as example. Click the Print button 
on the main window to let the printer output the ECI2002 chart, and then click Measure 
to measure it.  

Return to the main window after the measurement. The buttons Setting and Create 
become activated. Click Setting if you want to modify parameters related to the 
generation of the device ICC file. Among them, the value displayed below CMYK is the 
value you specified in the step of total ink amount.  
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Figure 62 

Click OK to return to the main window, when you have done the settings. Now click 
Create to start creating the characterization profile. The Calculate progress bar shows 
the progress of the file generation. The generated profile will then be displayed, like 
ProfileD_0.tmp.  

Click Next to enter into the main window for source characterization.  

Step 5: Source Characterization 
If you want your digital printer to achieve the color output effect that is represented in a 
specific environment, you can define the profile of that environment.  

If you already have this ICC profile, select Load Source Profile. If you want to measure 
the ECI2002 color chart printed in that environment, select Create Source Profile to 
create the profile.  



Color Tools User Guide 

 49 

 
Figure 63 

As shown on the interface, the Color Tools builds in several international standard source 
profiles for you to choose. After the loading, you can click the Edit button to modify the 
saturation of the loaded profile. The modifying operation is NOT recommended for 
general users.  

 
Figure 64 

Click Next to enter into the interface for generating the data package.  

Step 6: Color Data Packaging 
This step is designed to package the proof data into a single proof file *.cmf.  
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Figure 65 

Note: If you haven’t set the source ICC in previous step, you can click the button  
aside the parameter CMYK Source, to specify a source ICC you will use.  

CMYK-CMYK Setting: To affect the color output of the CMYK entities in job.  

RGB-CMYK Setting: To affect the color output of the RGB entities in job, enabling the 
RGB entities to be output as per the color effect specified by the Simulation ICC option.  

Gray-CMYK Setting: To affect the color output of the Gray entities in job, enabling the 
Gray entities to be output as per the color effect specified by the Simulation ICC option.  

Rendering Intent: It’s a mode of color conversion and is available for each color space. 
Its four options enable different conversion results. Among them, the Relative 
Colorimetric is the most commonly-used option. Absolute Colorimetric is used when 
you want to simulate the paper white of the source device. 

Click the button Package Color Data to generate the .cmf file when you have defined 
the above settings. After the generation, the three Print Chart buttons become 
activated, and by clicking them, you can print out respectively the test page for the CMYK, 
RGB, and Gray modes, for purpose to view the color output effect of the current proof 
data.  

Click Next to enter into the main window for circular calibration.  
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Step 7: Circular Calibration 
The purpose of this step is to enable a better match between the output result of current 
device and the source characterization profile, so as to achieve an accurate simulation 
and an optimization on the color effect.  

 
Figure 66 

By default, the option Create Status Target on the main window is checked, and the 
button Finish is grayed. The purpose for creating status target is to get the device’s 
status result data that are output with current proof file, as a basis for evaluating color 
output result. If you don’t want to perform the circular calibration, you can uncheck 
Create Status Target to activate the Finish button.  

Loop Counter counts the times you have repeated (circulated). The button Print Chart 
enables you to print out the effect of the current circular calibration each time when the 
calculation is completed.  

Click Print to print out the ECI2002 color chart (at this time the chart is applied with 
proof data) and then measure it. Return to the main window when you finish the 
measurement, and you will see that the button Calculate becomes activated. Click it, 
and when the calculation is completed, you will see the average Delta E value being 
displayed at the Result column. This value at the first time is usually large. Now you can 
start the loop calibration, i.e. to repeat the Print, Measure and Calculate operations. In 
general, the Delta E will be reduced to a quite ideal value after two loops, and then you 
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can stop the circular calibration.  

Please click Finish to exit the calibration wizard. The generated .cmf file is stored under 
the CMF Path defined in the Properties Setup window (opened by clicking Properties 
Setup at the beginning of the wizard). Meanwhile the status target data is recorded in 
the proof file.  

4.3 Apply CMF File 
1. Run your ElecRoc Client, and open or create a job. The job should contain the PDF 
Generator and the Digital Printer nodes.  

 
Figure 67 

2. Configure the printer node’s processor parameters. At the Use CMF File dropdown list 
under the Color Calibration tab, choose the .cmf file you have just finished.  
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Figure 68 

3. Submit pages to the printer node when you have done the configuration. The printer 
node can accept directly the output pages from PDF Generator.  
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Chapter 5 View & Edit CMF 
In the Color Tools, by clicking the toolbar icon , or choose the main menu item File > 
Open CMF, you can open a .cmf file for purpose of viewing or editing.  

 
Figure 69 

Click the Load button to choose the .cmf file you want to open. And after the loading, 
click OK to enter in the viewing/editing window.  

5.1 View Data 

 
Figure 70 

A .cmf file contains the following data, which can be expanded for view respectively by 
clicking the columns at the left of the window. Some data can even be edited.  

1. Basic Information 
Here shows the device information and other custom information given at the time you 
created the .cmf file. Basic information is generally used as sort of identifiers or notes. 
The custom information can be edited (click Modify to save the editing). For example, 
each time when you revise your .cmf file, you can write here the revision time and 
content, for ease in future reference.  
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2. Linearization Curve 
Here shows the detailed data about the linear curve.  

The linear data can be edited. Double-click the value in the Out column to turn it into an 
edit box, input new value and then press Enter key. You can also drag the right curve to 
edit the data. If needed, you can click Print to print out a chart, checking the editing 
effect. The button Undo enables you to return the curve to the state at the time you 
opened it.  

 
Figure 71 

3. 3D Table 
Here shows the detailed data about the device calibration file. This data can only be 
viewed.  

 
Figure 72 



                      Color Tools User Guide 

56 

The In values refer to the initial CMY values of the color blocks in the device calibration 
chart. The Out values refer to the color values that are to be used for printing the chart 
after the calibration. Target values are the LAB values measured from the printed chart, 
i.e. the data from the device state file created in the .cmf file. The Measure values are 
measured data after re-calibration. Statistic is the color difference between measured 
and target values after re-calibration.  

4. 4D Table 
Here shows the output and color difference for the ECI2002 color chart in your .cmf file.  

 
Figure 73 

The In values are the initial CMYK values of ECI2002 chart’s color blocks. Out values are 
the CMYK values conversed with the 4D table. The Target values are the lab values for 
the CMYK values with source ICC. The Measure values are the lab values measured from 
the printed chart. Statistic is the color difference between the target and measured 
values.  

5. Spot colors 
Here shows the spot color in your .cmf file, if any. Spot color information includes spot 
color name, color mode, color values. The color mode refers to the color mode for the 
color tune curve corresponding to the spot color. The curve is displayed at the right. The 
Tone slide bar and the output CMYK values below are closely correlated. By moving the 
slide bar, you can see corresponding CMYK output values.  
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Figure 74 

6. Total Ink & Paper White 
Here you can see the total ink amount and the rendering intent used for generating the 
4D table. If the intent is Absolute Colorimetric, you can then edit the paper white.  

 
Figure 75 

CMYK Black Reserve: If checked, the system will directly use black ink to print the pure 
black process color (only the K in CMYK is NOT equal to 0 in this case). This option was 
set in the Properties Setup window before you made the .cmf file, thus is displayed 
grayed here.  

CMYK Solid Retain: If checked, the color of CMYK=100% will be remained unchanged. 
If not, such color will still be conversed by the .cmf file.  

Gray Output Use Black: If checked, Gray graphic entity will be output with only the 
black ink. If not, such entity will be conversed by the .cmf file.  
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5.2 Re-calibration 
When your device state or the environment where it is located has been changed, and 
consequently has affected the color output result, you can make use of the re-calibration 
to correct the output.  

1. In the Color Tools, use the main menu item File > Open CMF, or the toolbar icon  to 
open the .cmf you want to re-calibrate.  

 
Figure 76 

2. The toolbar icon Re-calibration  becomes activated. Click it to enter in the user 
interface. Please ensure that your device is in normal working state before the 
re-calibration.  

 
Figure 77 
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5.2.1 Calculate dE Before Calibration 
Before the re-calibration, we recommend you to perform a color difference calculation, so 
as to know how big the difference is between the current device state and the state 
recorded in the .cmf file.  

To perform the calculation, please check the box Get Data. Before you click Print to print 
out the color chart, you are recommended to check the option Use small chart to 
calculate dE, which means to print out a small chart, as shown in the below. If not 
checked, the ECI 2002 chart will then be printed.  

 
Figure 78 

After the printing, click Measure to measure the chart. The color difference between the 
current device state and that in the .cmf file will be then displayed aside dE parameter.  

 
Figure 79 

Take the above figure as example, the dE value of 4.15 is bigger than the pre-defined 
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threshold of 2, therefore a calibration becomes necessary.  

The button Save Data enables you to save the measured result as a .txt file, while the 
button Load Data enables you to load such saved .txt file.  

There are two modes for re-calibration: quick calibration and entire calibration. Each time 
when you enter in the re-calibration’s user interface, you can choose only one of the two 
modes. Next, we will introduce them respectively.  

5.2.2 Quick Calibration 
This calibration requires that the current solution contains the linearization target data, 
which can be created in the Linearization step of the calibration wizard.  

As a fast way of color calibration, it requires no repetition of printing & measuring.  

Click the button Quick Calibration to enter in its user interface.  

 
Figure 80 

As indicated on the window, please click in turn the buttons Print and Measure to 
perform the printing and measuring operations, and after the measurement, click 
Finish.  

5.2.3 Entire Calibration 
This calibration requires that the current solution contains the device state file, which can 
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be created in the Device Calibration step of the calibration wizard.  

This mode requires repetition of printing & measuring.  

1. Click the button Entire Calibration to enter in its user interface.  

 
Figure 81 

2. Click the button Print to print out the color chart. And then click Measure to enter in 
the measuring window, measuring the printed chart. After the measurement, click Init 
Loop Print. The Color Tools will then calculate and correct automatically in background.  

3. As indicated by the arrows, continue to measure and loop print, and get the dE value. 
Repeat this operation till you are satisfied with the color difference.  

4. Click Finish to complete.  

5.2.4 Calculate dE After Calibration 
After the recalibration, if needed, you can choose to perform a color difference calculation. 
When you have returned to the Calibration Setting window, use the buttons Print and 
Measure in the Calculate dE After Calibration area, to perform the printing and 
measuring operation, and then get the color difference value.  
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Figure 82 

Note: The color charts used before and in the re-calibration must be the same. If the 
color difference after the recalibration is smaller than that before the recalibration, 
choose Calibration OK; otherwise, you can choose Calibration Cancel.  

5.3 Spot Color Tool 
Only when the spot color is contained in the .cmf file, it will then be conversed by the 
color logic in the .cmf file. Otherwise, it will be processed as per the RIP settings. 

In case that the spot colors are NOT output accurately under the control of .cmf file, you 
can use the spot color tool in Color Tools to make a color calibration.  

5.3.1 Basic Setting 
1. Open the .cmf file that you want to calibrate.  

2. Click the toolbar icon Spot Color Tool  to enter in its user interface.  
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Figure 83 

At the left of the window, the Spot In Cmf File list refers to the spot colors contained 
already in your .cmf file, while Spot waiting to add refers to the spot colors loaded after 
you have entered in the spot color tool. Choose a spot color and then you can see its 
detailed properties at the right.  

Find: If there are many spot colors in your list, you can find your spot color easier by 
using the Find button.  

Add: You can click the Add button to add a chosen spot color from the list Spot waiting 
to add to the list Spot In Cmf File. This button can also add the spot color you are 
inputting into the list. Clicking on the Add button is needed every time when you edit 
your spot color and want to save your modification.  

Delete: Use this button when you want to delete a spot color from the list.  

Load: This button is used to load spot colors from a .pdf file or a .spt file. The loaded spot 
colors will then be displayed in the list Spot waiting to add.  

Spot Color Name: The name of the spot color.  

Use Source ICC: This setting controls how CMYK spot colors are conversed. Options in 
the dropdown list are various source ICC profiles. If not checked, the printing device’s 
color space will be used. If checked, source color space will be mapped into by way of 
color conversion.  
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CMYK/Lab: Here shows the detailed color values. Note that only spot colors defined in 
Lab mode can be refined.  

Curve Mode: The mode of the spot color tune curves. Lab spot colors support CMYK or 
Lab modes, while CMYK spot colors support only CMYK mode.  

Refine: There are two refine types, General and Accurate. The Accurate type is 
usually recommended. The refinement is applied only to Lab spot colors. For CMYK spot 
colors, if needed, you can choose a proper source ICC to convert into Lab mode, and then 
perform the refinement.  

5.3.2 Add Spot Color 
1. Create a spot color 

Choose the spot color list Spot In Cmf File, and you can see that the edit box Spot 
Color Name becomes activated. Input a name, and its color values, and other properties 
if needed, and then click Add. In this way, you can create a spot color under the Spot In 
Cmf File list.  

2. Add from the list Spot waiting to add 

Click the Load button to open a .pdf file that contains spot colors. This action can load the 
spot colors from the PDF file into the list Spot waiting to add. And then choose a loaded 
spot colors, click Add to add it into the list Spot In Cmf File. 

5.3.3 Spot Color Refinement 
CMYK spot colors can be calibrated by simply changing the CMYK values. If needed, the 
CMYK values can turn to Lab values by applying a source ICC. Only Lab spot colors can be 
refined. There are two types, General and Accurate. They have the same purpose, i.e. 
by way of loop calibration, making the output result closer to the target.  

1. General Refine 

This type refines only one spot color each time, and supports only the Eye-One device.  

In the main window of the spot color tool, tick the box in front of the spot color you want 
to refine, and choose the General Refine option in the Refine dropdown list, and then 
click the button Refine. The tool first hints that this type will use the Eye-One device. 
Please choose Yes to continue.  

The spot color measuring window appears. At the right shows the target values for 
current spot color. This value, if needed, can be re-obtained by clicking the button 
Measure Target and then measuring.  
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Figure 84 

Click Print to print out a single color block of the current spot color. And then click 
Measure to measure the printed spot color block. After the measurement, both the 
measured color values and the color difference compared with the target values will be 
listed at the left table. Repeat the “print and measure” operation till you are satisfied with 
the color difference or the color difference rebounds. And then, choose the best result 
from the left table, and click OK. 

Return to the main window of the spot color tool. Now the spot color values will be 
updated as per the result of the refinement. Click Finish to save and exit.  
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Figure 85 

2. Accurate Refine 

In the main window of the spot color tool, tick the box in front of the spot color you want 
to refine (three spot colors at most can be ticked this time), and choose the Accurate 
Refine option in the Refine dropdown list, and then click the button Refine.   
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Figure 86 

If you have chosen more than one spot color, and want to measure the target values of 
the spot colors first, please choose the spot color from the dropdown list, and click 
Measure Target to perform. The refinement operation can be continued after you get 
the target values. In case that you have already gotten the target values, you can ignore 
the measurement, and perform the refinement directly.  

The refinement can be completed by clicking repetitiously the Print and Measure 
buttons, as indicated by the arrows, and performing corresponding printing and 
measuring operations, till you get the satisfied color difference value or the color 
difference value rebounds.  
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Figure 87 

After the refinement operations, choose a best result from the left table, and click OK. 
Now, return to the main window of the spot color tool. The spot color values will be 
updated as per the result of the refinement. Click Finish to save and exit. 

5.3.4 Spot Color Tune 
The spot color tool supports the application of a color tune curve, which can control the 
spot color’s middle tone.  

The tune curve can be edited in the spot color tool, or in the viewing interface of the .cmf 
file.  
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Figure 88 

For Lab spot colors, the curve mode can be CMYK or Lab. For CMYK spot colors, the curve 
mode is CMYK. Edition can be made after a separation has been specified from the Color 
Plane dropdown list. The Reset button enables a restoring to the default curve state.  

5.4 QA Tool 
This tool is used as a color difference assessment tool, providing the data basis to assess 
if the color quality reaches the standard. The QA tool shows both the color difference 
between the actual and ideal values for each color block, and the distribution map of the 
ideal and actual color spaces.  

5.4.1 Basic Setting 

Click the toolbar icon  in Color Tools’ main window to enter in this tool’s user 
interface. 
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Figure 89 

1. Choose a pattern. Currently two patterns are supported, ECI2002 and Founder_CMYK.  

Source for ideal values: The Source ICC dropdown list builds in some standard source 
ICC files, any of them can generate the ideal lab values. The Open option in the 
dropdown list enables you to use values from .cmf file as ideal values.  

 



Color Tools User Guide 

 71 

 
Figure 90 

Source for actual values: The actual vales can be loading data, or measured data from an 
already existing color pattern, or measured data from a freshly-printed pattern by 
applying specified .cmf file.  

2. Click the Source ICC dropdown list, and choose either ICC data or .cmf file that 
contains target data or state data.  

Note: In case that the data comes from measurement, please ensure the measured 
pattern is exactly the same as the selected pattern.  

3. Parameter setting. Click the button Parameter Setting to enter in the setup window, 
in which you can re-define the quality standards, i.e. the Check for values for all the dE 
categories. The standard is considered as reached when the calculated value becomes 
smaller than the Check for value; otherwise, means that the QA is failed. The default 
settings are used in general.  
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Figure 91 

5.4.2 Data View 
The color differences are displayed in the table Conclusion, when you have determined 
the ideal and actual values. If smaller than the Check for values, a tick mark  will 
appear in the Result column.  

Color blocks and their information, displayed at the top of the window, can be sorted by 
the lab values or color difference values.  

 
Figure 92 

Various dE calculation formulae are available in the DeltaE Formula dropdown list.  

The color difference assessment result can be exported by clicking the button Output 
Report. And such exported data can be loaded for view by clicking the button Input 
Report. The button Print Report is used to print out the currently-displayed result.   

5.5 Tune Curve 
Tune curve is designed to adjust slightly the whole tone or color, in case that tone or color 
related issues occur in the job output with .cmf file.   

Click the toolbar icon  in Color Tools’ main window to enter in this tool’s user 
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interface.  

 
Figure 93 

Define the curve respectively for the planes, according to actual need, and after that, 
click Save to CMF, to include the curve into the currently-opened .cmf file. Click Save 
and save the curve as a .duv file in case that the curve needs to be used in other .cmf file.  

5.6 Data Transform 
This tool is used to transform between the .cmf file generated by Color Tools and the 
proof package generated by earlier ElecRoc versions. It’s available only for digital proof.  

Click the toolbar icon  in Color Tools’ main window to enter in this tool’s user 
interface.  
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Figure 94 

There are two modes, CMF File-->Data Package, Data Package-->CMF File.  

Choose the transformation mode first, then choose file (click Select File) and specify the 
save path (click Save Path to specify), and then click Transform.  

In the mode CMF File-->Data Package, only one .cmf file can be transformed each 
time. While in the mode Data Package-->CMF File, not only one package but also all 
the package files under a same folder can be transformed one time. And if there is .spt 
file made for the package, by loading such .spt file (click Load), the spot colors can be 
included into the transformed .cmf file as well.  
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